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“El càncer és el preu que paguem per estar vius.” 

Dr. Joan Massagué
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Abreviatures:  

BBB: Blood Brain Barrier 

VCAM-1: Vascular cell adhesion molecule 1 

L1CAM: Cell adhesion molecule ligand 1 

FCM: Flavonoides del Citrus unshiu Marc 

PA: Plasminogen activator 

FDA: Food and Drug Administration  
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1. Objectius 

L'objectiu principal d'aquest projecte és el disseny de nous compostos derivats de l’indol i 

la quinolina per fer inhibidors de VCAM-1 i evitar la metàstasi en càncers.  

Objectius concrets: 

1. Conèixer la proteïna VCAM-1 i la seva influència en la metàstasi de càncers. 

2. Aprendre els conceptes i tècniques de modelització molecular. 

3. Aprendre a dissenyar nous compostos de forma racional, amb estructura base 

d'indol o quinolina que actuïn com a inhibidors de la proteïna VCAM-1. 

4. Aprendre a utilitzar eines de química computacional per a realitzar càlculs teòrics: 

Symyx Draw (disseny d'estructura 2D de les molècules, amb extensió .mol), Open 

Babel (canvia el format del disseny a un format previ en 3D, .pdb) i Autodock Tools 

(canvi del format .pdb al .pdbqt, amb el qual llançarem el docking). 

5. Utilitzar els programes Autodock Tools i Ligand Explorer per interpretar els resultats 

obtinguts. Aprendre a discutir els resultats i a optimitzar-los per iteració. 
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2. Introducció 

2.1. Càncer 

El càncer és una malaltia provocada pel creixement descontrolat d'un grup de cèl·lules. La 

malaltia es pot dividir en quatre fases: aparició de cèl·lules neoplàsiques, creixement tumoral, 

invasió del teixit original i migració al torrent sanguini i, finalment, la metàstasi en altres teixits 

de l'organisme. 

El càncer és, en part, desconegut per a nosaltres, però una de les peces clau en el conjunt de 

malalties que anomenem càncer és la metàstasi. Des de fa dècades, tractem de comprendre 

com i per què es desenvolupa un tumor en un òrgan o teixit diferent a l'afectat inicialment pel 

càncer. La resposta no és senzilla. 

S'han aconseguit avenços recents en pràcticament tots els tipus de tumor. La supervivència de 

les persones afectades per aquestes malalties ha augmentat i, en alguns casos, es parla de 

curació definitiva. 

Tot i així, hi ha detalls que se'ns escapen, i per això continuen morint persones que havien vençut 

les primeres batalles contra el càncer. 

Un dels detalls que se'ns escapen és la metàstasi. La investigació que publica l'equip del doctor 

Massagué a la prestigiosa revista científica Cell dóna una nova esperança. 

El càncer és un creixement descontrolat de cèl·lules que evolucionen formant tumors i, també, 

destruint teixits adjacents. En alguns casos, les cèl·lules canceroses s'estenen pel cos a través de 

la limfa o sang colonitzant altres òrgans. Aquest procés és anomenat metàstasi. 

Així doncs, el tumor primari s'expandeix mitjançant aquestes cèl·lules canceroses que s'infiltren 

en òrgans de tot el cos. Tot i que els mecanismes inicials de dispersió d'una cèl·lula tumoral i la 

seva posterior creixement metastàtic es coneixen, els factors que determinen la supervivència i 

adaptació d'aquestes cèl·lules cancerígenes disseminades encara estan per determinar. 

Una de les conseqüències més devastadores del càncer de pulmó i de mama és la metàstasi 

cerebral, i es considera que l'origen d'aquesta metàstasi cerebral és, en la majoria dels casos, el 

propi desenvolupament del càncer de pulmó i de mama. La letalitat d'aquesta metàstasi és deu 

vegades més gran que la dels altres tumors cerebrals sumats. 

No obstant això, el nostre organisme disposa d'una sèrie de mecanismes capaços de frenar o 

evitar l'entrada directa d'aquestes cèl·lules. La barrera hematoencefàlica (BBB, blood brain 
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barrier) és una estructura membranosa que serveix, principalment, per protegir l'encèfal de les 

substàncies químiques presents a la sang. Està formada per cèl·lules endotelials i és 

extremadament selectiva al pas de determinades substàncies que provenen de la sang. Al costat 

d'aquesta barrera, i com a suport de les cèl·lules endotelials, trobem els astròcits. No totes les 

cèl·lules canceroses aconsegueixen travessar la BBB i, de fet, tant els mecanismes com les 

molècules implicades en aquest procés són objecte d'estudi, i alguns s'han identificat.1,2 Les 

cèl·lules que aconsegueixen creuar la BBB i infiltrar-se en el cervell presenten una característica 

comuna: s'adhereixen als capil·lars formant un recobriment del vas; mentre que aquelles que 

no aconsegueixen superar-lo tampoc aconsegueixen evolucionar. 

Altres mecanismes de què disposa el nostre organisme per combatre les cèl·lules tumorals es 

basen en el sistema immunitari, com es mostra més endavant a la Figura 1. 

De fet, quan apareix una cèl·lula tumoral en el nostre organisme, el nostre sistema la reconeix i 

la destrueix. Les cèl·lules especialitzades en aquesta tasca són els limfòcits T, que posseeixen en 

la seva membrana una molècula anomenada PD-1. Les cèl·lules tumorals tenen en la seva 

membrana una molècula anomenada PD-L1 que actua d'escut per protegir-se de l'atac dels 

limfòcits T, de manera que aquests interpreten que no les han de destruir, per tant, tenen via 

lliure per proliferar en el nostre organisme i, posteriorment, quan el tumor inicial creix, produir 

metàstasi. Per tant, els fàrmacs basats en immunoteràpia es basen en bloquejar el receptor PD-

1 dels limfòcits T o el PD-L1 de les cèl·lules tumorals, deixant-les sense capacitat per ocultar-se 

del sistema immunitari i així els limfòcits poden atacar el tumor inicial. Prova d'això són els 

recents estudis del doctor Joaquim Bellmunt (Institut Oncològic Dana-Farber, Boston i Escola de 

Medicina de Harvard) en càncer de bufeta.3  
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*Figura 1: Extreta de l’element 12 de la bibliografia 
*Figura 2: Extreta de ccforum.com/content/16/1/R7/figure/F1  

             

   

Figura 1: Mecanisme d’inhibició de cèl·lules tumorals basat en el sistema immunitari* 

Què és el que mata les cèl·lules cancerígenes que superen la BBB i què és el que permet a algunes 

sobreviure i evolucionar sobre el vas sanguini? En què es basen els reconeixements de les 

proteïnes de membrana de les cèl·lules tumorals i dels limfòcits T? 

2.2.  Els receptors de membrana VCAM-1 i L1CAM  

L1CAM i VCAM-1 són dues proteïnes de l'endoteli vascular que s'activen (s'expressen) i faciliten 

l'adhesió de limfòcits, monòcits, eosinòfils i basòfils (diferents tipus de leucòcits) en aquest 

epiteli. (Figura 2) 

 

Figura2: mecanisme d’interacció amb LFA-1. VCAM-1 com a receptor a l’endoteli* 

http://ccforum.com/content/16/1/R7/figure/F1
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Com es pot veure a la figura 2, un leucòcit pot interaccionar amb diferents receptors, entre ells 

veiem VCAM-1 que facilita la seva adhesió a l'epiteli. Algunes cèl·lules de melanoma poden 

utilitzar VCAM-1 (és a dir, produir-ne una expressió aberrant) per adherir-se a l’endoteli 

vascular. 

Veiem, per tant, que l'estudi de l'estructura de les molècules inibidores de VCAM-1 descrites a 

la bibliografia esmentada anteriorment és de vital interès per al disseny de la nostra nova 

proposta d'inhibidor. 

Aquesta proposta pot partir de dues estructures heterocícliques d'interès: les quinolines i els 

indols. En el present treball s'avaluarà virtualment l'activitat dels indols i els seus derivats com a 

possibles inhibidors de VCAM-1. 

Es troba descrit a la bibliografia que un grup de gens anomenats SERPINI1 són els responsables 

de codificar un inhibidor anomenat PA (plasminogen activator). Aquest inhibidor combat la 

neuroserpina.4 

L'article identifica les plasmines com les defenses contra la invasió metastàsica al cervell; les 

plasmines fan front a la metàstasi cerebral mitjançant dos processos diferents: senyals químics 

que rebutgen les cèl·lules canceroses i inactivant la molècula L1CAM. Les cèl·lules metastàsiques 

procedents del càncer de pulmó o de mama mostren alts nivells de serpines anti-PA.
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Bloquejant la proteïna L1CAM, estaríem bloquejant la metàstasi cerebral, per això farem el 

disseny virtual d'un inhibidor per a aquesta proteïna.  

.  

Figura3: Supervivència o supressió de les cèl·lules metastàsiques als capil·lars al cervell* 
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2.3. Els inhibidors 

2.3.1. L’indol 

Es troben descrites a la bibliografia multitud d'estructures que poden actuar com a inhibidors 

de VCAM-1, com alguns flavonoides presents en cítrics.5 Els cítrics s'han utilitzat en medicina 

tradicional com a tractament per a multitud de malalties, inclòs el càncer. A l'article esmentat, 

s'incideix especialment en la metàstasi, demostrant com alguns flavonoides del cítric unshiu 

Marc (FCM) tenen activitat antimetastàsica inhibint l'adhesió de molècules i la posterior invasió 

de cèl·lules del càncer de mama. 

L'empresa farmacèutica Hoffman la Roche descriu en la seva patent de número WO 1999010313 

A1 multitud d'estructures derivades de N-aroylphenylalanine que actuen com a inhibidors de la 

unió entre VCAM-1 i VLA-4 que desencadenaria l'activació de l'endoteli facilitant l'adhesió de 

cèl·lules de melanoma. A 

L' indol i els seus derivats més simples són sòlids cristal·lins incolors. Aquesta estructura es troba 

a la cadena lateral de l'aminoàcid triptòfan, que el nostre organisme no pot sintetitzar i 

necessitem ingerir en la dieta. És el producte de la degradació d'aquest aminoàcid, que porta a 

terme un bacteri. També pot ser sintetitzat en un laboratori. 

6
7

4
5

N
H
1

3

2

 

Indol deriva de la paraula Índia, un tint blau importat d'aquest país i són probablement les 

estructures heterocícliques que trobem més esteses a la naturalesa formant part de nombrosos 

compostos d'interès. Per exemple, la serotonina (neurotransmissor molt important del sistema 

nerviós central) (1), la melatonina (hormona que controla el ritme diürn de moltes funcions 

fisiològiques) (2), el triptòfan (un aminoàcid essencial i constituent de moltes proteïnes) (3 ) i la 

dietilamida de l'àcid lisèrgic (LSD) (4).6 
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Partint de l’indol, en dissenyarem una molècula derivada que és una millor a la VCAM-1. Amb la 

tècnica del docking, sabrem quines d'aquestes molècules són les que formen una unió més 

estable, i aquests seran els que inhibiran millor la proteïna, per tant, susceptibles de ser 

medicaments més efectius contra la metàstasi cerebral. 

L'inhibidor (o inhibidors) que dissenyem busquen la millor complementarietat amb la nostra 

diana de treball “target”. No s'han dissenyat tenint en compte la seva facilitat de síntesi sinó la 

seva capacitat d'inhibició. Sense aquesta restricció d'accessibilitat sintètica es pot realitzar un 

estudi teòric més exploratiu i, un cop es trobin molècules amb prou capacitat inhibitòria, es 

poden realitzar modificacions estructurals perquè, sense perdre capacitat d'inhibició siguin més 

fàcilment sintetitzables. En aquest sentit, la química computacional ha simplificat el 

procediment de creació de fàrmacs. 

Encara no tenim certesa que les molècules que hem creat arribin a sintetitzar mai, hem dissenyat 

fàrmacs que són susceptibles d'aturar la metàstasi. 

 

 

1 

4 

3 

2 
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2.3.2. La quinolina 

La quinolina és un compost orgànic aromàtic amb un nucli benzènic condensat amb un altre de 

piridina. La seva fórmula molecular és: C9H7N. S'acostuma a fer servir per a la fabricació de 

colorants i la síntesi orgànica. 

Les propietats físiques de la quinolina són les següents: 

 Punt d'ebullició: 238 oC 

 Punt de fusió: -15 oC 

 Densitat: 1,09 (aigua=1 g/cm3) 

 Solubilitat en aigua: insoluble en aigua freda, soluble en aigua calenta.  

Altres maneres de anomenar la quinolina són: 

 1-Bencina 

 Benzopiridina 

IDENTIFICADORS QUÍMICS DE LA QUINOLINA: 

Els podem resumir amb el següent esquema de colors1:  

1. Groc i blanc: indiquen que és un material que per si sol és normalment estable, fins i tot 

en condicions d'incendi i que no reaccionen amb l'aigua.  

2. Vermell: indica que la quinolina és un material que s'ha d'escalfar moderadament 

perquè succeeixi la ignició.  

3. Blau: indica que és un material que encara que la seva exposició sigui curta, pot causar 

danys temporals o, fins i tot, permanents.  

 

 

 

                                                           
1 La imatge i la informació de l'apartat, l'hem tret del següent lloc web: 

http://www.cosmos.com.mx/wiki/dpdl/Quinolina 
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3. La química computacional en investigació oncoterapèutica  

La química computacional és una disciplina científica que permet el disseny de fàrmacs (entre 

moltes investigacions que es poden realitzar computacionalment) amb una activitat definida 

reduint despeses i temps en les primeres fases del seu disseny. Permet descartar molts 

compostos en saber que no seran efectius. Mitjançant el docking, podem veure quins són els 

fàrmacs que s'adheriran millor a la molècula VCAM1, el nostre target o molècula objectiu. 

Crearem derivats de l' indol per inhibir (teòricament) la proteïna VCAM-1, procés que faria, com 

hem vist en l'apartat anterior, aturar el procés de la metàstasi. Per saber quines són les 

molècules creades que inhibiran millor la proteïna VCAM-1, veurem com d'estable és la unió 

entre les dues molècules. Per cada docking, obtindrem diversos resultats (fins a 9 per docking), 

corresponents a les diferents conformacions i disposicions que pot adoptar el nostre lligant; 

encara que utilitzarem la conformació resultant del docking amb l'energia d'unió (Ebinding) més 

negativa, és a dir, la que formi un complex més estable amb el receptor. Els resultats seran 

l'energia que desprèn la unió de les dues molècules, en -Kcal / mol. Com més gran sigui el valor 

absolut d'aquest número, més estable serà i, per tant, tindrem una millor inhibició. 

La interpretació d'un resultat com a favorable o desfavorable en base als càlculs més o menys 

negatius en Kcal / mol indiquen, per exemple, que si una molècula polar en una cavitat apolar 

ens dóna un valor menys negatiu o fins i tot positiu "prefereix" estar fora d'aquesta cavitat que 

dins, és a dir, interacciona desfavorablement amb la cavitat. Aquests càlculs teòrics hauran de 

ser contrastats amb els experimentals. 

El docking és una tècnica que serveix per calcular la conformació òptima d'una molècula en una 

cavitat, trobant l'orientació adequada dels enllaços formats entre les dues molècules (un 

receptor i un lligand). Per a això, es defineix una funció "energia" que depèn de la posició relativa 

de les molècules, i la posició òptima és la que presenta un mínim en la funció. Un cop coneguda 

la disposició dels enllaços es pot conèixer la força d'atracció que els uneix. Gràcies a aquesta 

tècnica podem comparar la força que uneix dues molècules. El receptor és, en general, una 

proteïna i el lligand una molècula petita. En el nostre cas, el receptor serà la molècula VCAM-1 i 

el lligand seran els derivats del indol que anirem dissenyant i comparant mitjançant tècniques 

de docking..  

Val a dir que, si en matemàtiques, en buscar els màxims i mínims d'una funció igualem la 

derivada d'aquesta a 0; podem obtenir diverses solucions, també obtenim diverses solucions en 

el docking a causa de la complexitat de la funció energia (depèn de multitud de coordenades). 
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Per això, cada programari de docking utilitza una funció diferent, ja que aquesta està plena 

d'aproximacions. 

Per tant, el nostre èxit no es basa en un resultat concret sinó que serà relatiu als resultats 

obtinguts al llarg del projecte. 

Una bona estratègia per realitzar els càlculs i presentar els resultats, si sempre fem servir el 

mateix programa i el mateix protocol, és ordenar els valors d'afinitat de les molècules que es 

vagin assajant.  

3.1. Procediment seguit al fer un docking 

En aquest apartat es detallarà quin és el procés que hem seguit a l’hora de fer tots els dockings. 

Els autors d'aquesta informació són Aleix Viñolas Puig, estudiant de Doctorat en Medicaments i 

Salut de la Facultat de Farmàcia de la Universitat de Navarra i la  Dra. Maria Font Arellano , 

professora titular de Química Farmacèutica de la Facultat de Farmàcia de la Universitat de 

Navarra.  

Per començar, el primer que farem, serà buscar a la pàgina web www.pdb.org 2   l'arxiu 

cristal·logràfic de la VCAM-1. Quan l'hàgim trobat, descarregarem l'arxiu i l'obrirem amb el Word 

Pad. Seguidament copiarem tot el contingut del fitxer en un nou document que anomenarem: 

VCAM1_lig.pdb. Després, en aquest nou arxiu, esborrarem les coordenades dels heteroàtoms 

que no siguin cations ni aigües enllaçades amb aquests cations propis del lloc actiu. Guardarem 

l'arxiu amb el nom: VCAM1_rec.pdb  

Seguidament, el que haurem de fer és passar l'arxiu del format .pdb al format .pdbqt, això ho 

aconseguirem mitjançant l'ús del programa AutoDockTools, els passos presentats de manera 

esquemàtica seran els següents: 

  

                                                           
2 Lloc web que recull dades sobre proteïnes i àcids nucleics. 
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PAS 1 

1. Obrir l'arxiu: VCAM1_rec.pdb (Ligand -> Input -> Open -> VCAM1_rec.pdb).  

2. Edit -> Hydrogens -> Add 

3. File -> Save -> VCAM1_recH.pdb 

4. Borrar la pantalla (clic deret sobre la finestra i clicar sobre: "delete"). 

5. Ligand -> Input -> Open -> VCAM1_recH.pdb 

6. Ligand -> Torsion Tree -> Detect Root 

7. Ligand -> Torsion Tree -> Show Root Expansion  

8. Ligand -> Output -> Save as -> PDBQT -> VCAM1_recH.pdbqt 

9. Ligand -> Torsion Tree -> Hide Root Expansion 

PAS 2 

1. Obrir l'arxiu: VCAM1_rec.pdb (Ligand -> Input -> Open -> VCAM1_rec.pdb). 

2. Edit -> Hydrogens -> Add 

3. File -> Save -> Write PDB -> recH.pdb (en guardar-lo, hem de seleccionar les 

opcions: ATOM i CONECT).  

4. Borrar la pantalla (clic deret sobre la finestra i clicar sobre: "delete"). 

5. File -> Open -> VCAM1_recH.pdb  

6. Grid -> Macromolecule -> Open -> VCAM1_recH.pdb3. 

7. Guardar com VCAM1_recH.pdbqt  

8. Grid -> Set Map Types -> Choose Ligand -> VCAM1_ligH.pdbqt 

9. Grid -> Gridbox: - Center -> Center on Ligand        

      -Spacing -> 1.000 angstroms    

      -Number of points in x-dimension: 20   

      -Number of points in y-dimension: 20    

      -Number of points in z-dimension: 20   

      -File -> Close Saving Current 

10. Grid -> Output -> Save GPF ->  VCAM1_gridbox.gpf 

  

                                                           
3 El programa automàticament s'encarrega d'eliminar els hidrògens no polars i afegir càrregues parcials.  
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PAS 3 

Un cop hàgim finalitzat tant el Pas 1 com el Pas 2, tractarem de preparar l'arxiu per al 

Docking que només haurem de fer una vegada i ens servirà per a tots els Dockings que 

fem, essent sempre imprescindible. Obrirem un bloc de notes amb el nom: 

DockingVina_VCAM1_recH.pdbqt_quinolina.pdbqt.txt. 

A l'arxiu hi haurem de posar el següent: 

out = DockingVina_VCAM1_recH.pdbqt_quinolina.pdbqt.pdbqt 

log = DockingVina_VCAM1_recH.pdbqt_quinolina.pdbqt.log 

receptor = VCAM1_recH.pdbqt 

ligand = Quinolina.pdbqt 

center_x = 25.509  

center_y = 14.84 

center_z = 27.155 

size_x = 20 

size_y = 20 

size_z = 20 

Quedant un document de text (amb el bloc de notes) com el de la següent imatge: 

Figura 20 
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PAS 4 

Mitjançant el programa cmd, farem un càlcul que ens permetrà calcular l'energia de 

Gibbs4, el valor ha de ser com més negatiu millor ja que això significarà que la unió és 

més forta i que serà necessària més energia per separar el complex. A nosaltres, ens 

interessa que la unió sigui el més fort possible perquè la proteïna (VCAM1) no pugui 

unir-se amb les altres proteïnes de la sang i acabar provocant la metàstasi. 

Els passos per obrir el programa cmd i fer un càlcul "Windows Scripting Language" han 

de ser els següents: 

1. Windows Inici -> Executar -> cmd  

2. Canvi de directori al directori d'arxius, hem d'escriure:                  

 cd C:\Documents and Settings\....\tdr  (és a dir, hem d'escriure "cd" i 

llavors copiar el directori de la carpeta on volem que es creï el Docking).  

3. Per executar l'arxiu de configuració del Docking, clicarem sobre "enter" i 

escriurem el següent:       

 C:\Vina\vina --config (directori de l'arxiu creat amb l' AutoDock Vina) 

DockingVina_VCAM1_recH.pdbqt_quinolina.pdbqt.pdbqt.txt 

4. Clicarem sobre "enter" i el càlcul comença a realitzar-se sol.  

 

 

 

Quan s'hagi acabat el càlcul, veurem que tindrem de tres a nou resultats, haurem 

d'escollir el resultat més negatiu ja que aquest serà amb el qual obtindrem una unió més 

forta entre la quinolina i la VCAM1.  

Ara, només ens falten els passos per aprendre a analitzar els resultats del Docking i com 

se situa la quinolina al centre actiu de la VCAM1. 

  

                                                           
4 És l'energia que s'ha de subministrar a la unió de la proteïna i el seu lligand per separar-los.  
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PAS 5 

1. Obrir l' AutoDockTools  

2. Analyze -> Dockings -> Open -> AutoDock Vina Results -> 

DockingVina_VCAM1_recH.pdbqt_quinolina.pdbqt.pdbqt 

3. Single Molecule with multiple conformations -> Ok 

4. Analyze -> Macromolecule -> Open -> Quinolina.pdbqt 

5. Analyze -> Dockings -> Show interactions     

  

6. En arribar a aquest punt, s'obriran dues finestres i,  a més a més, podrem 

visualitzar els ponts d'hidrogen. Podem manipular les opcions de les dues 

finestres que se'ns han obert, per tal d'alterar els factors que ens permetin fer 

una bona fotografia.                     

 -Set Background  -> Negre (s'observen millor els ponts  d'hidrogen).

 -Mouse ->  Mantenint clicat el botó esquerre podem desplaçar la 

molècula i observar-la des de tots els angles.     

 -Mouse -> Amb la rodeta del mouse podem fer ZoomIn o ZoomOut 

 - Al menú de l'esquerra de la finestra, podrem "clicar i desclicar" diferents 

opcions, com la que ens permet observar l'estructura secundària de la VCAM1 

així com les esferes dels àtoms dels aminoàcids prop del lligand. 

7. Observem la molècula des de tots els seus angles per intentar identificar algun 

pont d'hidrogen (s'identifiquen per ser uns punts de color verd amb una petita 

separació l'un de l'altre).  

8. Clicant les fletxes (dreta i esquerra del teclat), podem anar observant tots els 

resultats5 que hem obtingut en fer el Docking amb el cmd.  

 

 

 

 

 

 

  

                                                           
5 Ens refereim als resultats obtinguts en fer el "Windows Scripting Language" que hem esmentat que 

eren de 3 a 9. 
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PAS 6 

Una vegada tinguem l'enfocament que volem per a la fotografia, procedirem a fer-la: 

1. 3D Graphics -> Render Large Image -> BROWSE (Seguim la carpeta on volem 

guardar la imatge) -> Nom6.tif  

2. A la finestra amb opcions que se'ns obrirà, haurem de posar-hi:   

  -Requested Height: S'ajusta al valor anterior.  

   -Requested Width: 4800 (keep aspect). 

3. Render Image.  

 

Després d'aquest procediment, obtindrem una imatge que ocupa més o menys uns 50 

MB i estarà girada. 

Para girar-la (1) i disminuir-ne el pes perquè ocupi menys (2)7:  

1. Obrim el programa Paint:      

 -Imatge-> Girar -> Girar verticalment -> Acceptar  

 -Arxiu -> Guardar com -> Nom.png 

2. Obrim el programa Paint:      

 -Imatge -> Expandir o contreure -> Horitzontal 60%/Vertical 60%

 -Arxiu -> Guardar com -> Nom.png 

 

  

                                                           
6 En dir Nom, ens referim al nom amb  què volem que es guardi la imatge.  
7 Aquest procediment és opcional. 
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3.2. Regles de lipinski 

Per assegurar-nos d'una correcta biodisponibilitat oral d'un medicament, aquest ha de 

complir totes i cadascuna de les cinc regles de Lipinski8:    Figura 3 

1. -Pes molecular: < 500 Dalton 

2. -Nombre de donadors de ponts d'hidrogen: < 5 

3. -Nombre d'acceptors de ponts d'hidrogen: < 10 

4. -Log P ("coeficient repartiment" [octanol]/ [aigua]): <5  

5. -Es consideren excepcions els substrats de transportadors de                

membrana i els productes naturals. 

Per dissenyar els nostres compostos, haurem de seguir un determinat ordre ja que, en 

cas contrari, la tasca se'ns farà extremadament laboriosa i pesada. Seguirem el següent 

ordre: 

 1. Buscarem posicions moleculars de ramificació de la quinolina.  

 2. Aquí serà on posarem els substituents següents:  

  -Poc i molt voluminosos (-H, -CH3, -Ph, -Naft).  

  -Acceptors de ponts d'hidrogen -NO2, -N(CH3)2, -OCH3).  

  -Donadors de ponts d'hidrogen ( -NH2, -OH, -SH).  

  -Electroatractius ( -CF3, -F, -Cl, -Br, -I ).  

          3. Provarem compost mitjançant l' AutoDockTools situant-lo a la diana (VCAM-1).  

 4. Posteriorment prepararem una taula com la que tenim a continuació que ens 

 facilitarà l'anàlisi de les nostres modificacions de quinolina, per poder escollir el 

 millor compost: 

Compost Energia d'unió 
(kcal/mol) 

Núm. de ponts 
d'hidrogen 

Quinolina_1 -5,5 1 

 

 5. Un cop analitzada una posició, escollirem les dues modificacions que millor 

 resultat donen i repetirem el procés en una altra posició de la molècula.  

 6. Al final, seleccionarem els tres millors candidats per a fer un fàrmac. 

 Aquest serà el procediment que seguirem meticulosament al llarg de tot el treball, per 

aconseguir assolir el nostre objectiu final, fer un fàrmac per inhibir la VCAM-1.  

                                                           
8 Cristopher A. Lipinsky va formular les cinc regles l'any 1997, basant-se en la observació de què els 

compostos químics utilitzats en medicaments són molècules petites i lipofíliques. .  
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4. Resultats i discussió 

4.1. INDOL 

4.1.1.  Substitució d’hidrògens 

En el lloc de cada un dels hidrògens, col·locarem un dels radicals següents: -OH, -F, -NH2 o CH3, 

D'aquesta manera, veurem quins dels radicals que utilitzarem funcionen millor, i quines 

posicions són les més favorables. Malgrat aquestes consideracions, el resultat és orientatiu, ja 

que més endavant crearem molècules més grans i la distribució de la càrrega serà diferent. 

Farem el mateix amb els grups antracè i carbonil. 
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R

 

                                      1 

L'energia d'unió entre l'indol (sense modificacions) i la molècula VCAM-1 és de -4,7Kcal / mol
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Nota: A totes les taules on expressem radicals indiquem el punt d’unió amb un metil, per 
criteris de simplicitat. 

TAULA 1: valors d'afinitat en kcal / mol. Cada valor indica el resultat energèticament més 

favorable, molècula més estable obtinguda a cada docking per la unió del substituint en cada 

heterocicle. 

 

Qualsevol posició de l'indol substituïda per un grup discret dóna com a resultat valors baixos, 

que oscil·len entre -4,6 i -5,3; per tant, seria possible augmentar aquests valors, en teoria, 

augmentant el volum de l'estructura proposada és a dir: unint-la a grups més grans. Com es pot 

veure a la taula anterior, les substitucions amb 9 i 2-antranil donen com a resultat energies 

d'unió lleugerament superiors (al voltant de -7kcal) respecte a 1 i 2-naftil. Per tant, les noves 

estructures propostes hauran de tenir en compte aquest grup més voluminós. Addicionalment, 

la possibilitat que aquests substituents continguin grups polars (àtoms d'electronegativitat 

elevada com O, N, F) porta a pensar que la formació d'enllaços per pont d'hidrogen i altres 

R 
H 

Energia 
unió   R H 

Energia 
unió   R H 

Energia 
unió 

-OH 

1 -5,3   

-NH2 

1 -5,3   

-F 

1 -4,8 

2 -5,3   2 -5,0   2 -5,0 

3 -5,2   3 -5,2   3 -4,9 

4 -4,9   4 -4,9   4 -4,8 

5 -5,2   5 -5,3   5 -5,0 

6 -5,0   6 -5,0   6 -5,0 

7 -4,8   7 -5,1   7 -4,9 

                      

R 
H 

Energia 
unió   R H 

Energia 
unión   R H 

Energia 
unió 

-CH3 

1 -4,6   

-CO 

1  -5,3   

1-NAFTIL

CH3

 

1 -5,9 

2 -4,9   2  -5,3   2 -6,5 

3 -4,9   3  -5,3   3 -6,2 

4 -4,8   4  -5,4   4 -6,1 

5 -4,7   5  -5,2   5 -6,2 

6 -4,9   6  -5,4   6 -6,5 

7 -5,0   7  -5,4   7 -6,1 

                   

 
H 

Energia 
unió   R H 

Energia 
unió   R H 

Energia 
unió 

2-NAFTIL
CH3

  

1  -6,6   9-ANTRANIL

CH3

 

1 -6,2   
2-ANTRANIL
CH3

 

1 -7,0 

2  -6,5   2 -7,1   2 -6,7 

3  -6,8   3 -7,1   3 -6,6 

4  -6,8   4 -6,3   4 -6,8 

5  -6,6   5 -6,8   5 -6,7 

6  -6,5   6 -6,7   6 -6,7 

7  -6,6   7 -6,7   7 -6,5 
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interaccions intermoleculars serien possibles entre VCAM -1 i l'inhibidor proposat augmentant 

l’afinitat entre les dues molècules.  

 

4.1.2. Disseny de molècules inhibidores 

 

A l'apartat anterior, hem vist com la substitució en qualsevol posició de l'indol amb grups 2- o 9- 

antranil dóna bons resultats des del punt de vista d'afinitat amb l'inhibidor. Si fos possible trobar 

una posició de l'indol més afavorida, en aquest sentit es podria obtenir un inhibidor més actiu.  

Es troben descrits a la bibliografia indols amb substituents en posició 3 que han demostrat ser 

compostos biològicament interessants i que posseeixen una variada activitat biològica.4,5 Els 

derivats d’indol s'utilitzen com a esquelet base d'un gran nombre de inhibidores d'enzims com 

la proteïn-cinasa i altres inhibidors antibacterians i antivirals.6 En la referència 6 es descriu 

l'activitat d'una tirosina-cinasa en un gran nombre de tumors epitelials, com el d'ovari, còlon, 

pulmó, mama, pròstata i pàncrees. Actua com a modulador de la invasió de les cèl·lules 

cancerígenes i de les metàstasis reduint la seva adhesió i facilitant la seva mobilitat, per tant, el 

disseny d'un inhibidor en aquest camp és de gran interès. Per això, utilitzant aquest esquelet 

d’indol 3-substituït o dels seus derivats de demostrada activitat inhibidora de l'activitat invasiva 

del càncer podria donar resultat en el cas de la VCAM-1. 

A la taula següent es resumeixen els resultats obtinguts amb substituents de voluminositat 

creixent en posició 3. 

 

 

 

 

 

 

 

 

 

 

 

TAULA 2: valors d’afinitat en Kcal/mol. En indols 3-substituïts. 
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8  Af=-6,1kcal/mol 9  Af=-5,9kcal/mol 10  Af=-5,2kcal/mol 

 
S'observa un increment de l'estabilitat en les molècules 2, 3 i 4 pel fet d'augmentar el volum del 

substituent i fer-ho en posició 3. Les estructures 5 i 6 incorporen un grup CH2 entre indols 

traduint-se en una disminució de l'estabilitat de la unió amb VCAM-1. Per tant, cal buscar 

heterocicles fusionats o bé unions directes entre ells. 

També es continuaran estudiant estructures indòliques amb substitució en posició 3, ja que es 

troben descrits en alguns treballs aquests derivats que actuen modulant l'activitat d'un grup de 

tirosina-cinases. Aquests enzims que intervenen en el control d'un gran espectre de funcions 

biològiques (creixements cel·lulars, divisió, invasió, adhesió) s'han observat en un nombre de 

tumors epitelials com el d'ovari, còlon, pulmó i mama. Per tant, aquestes tirosina-cinases actuen 
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com a moduladors de la invasió cel·lular que provoca el càncer i les seves metàstasis, reduint 

l'adhesió i facilitant-ne la seva mobilitat. L'estructura 6, de demostrada activitat davant 

d'aquests enzims, s'ha avaluat a nivell clínic en l'estudi del càncer ovàric. Per aquest motiu s'ha 

decidit incloure-la en l'estudi.10  

La molècula 7 va mostrar activitat moderada davant les cinases, per aquest motiu es va decidir 

estudiar si la seva activitat podia ser diferent amb VCAM-1, ja que, igual que 6 era també una 

estructura sintetitzada en el mateix article. Els resultats indiquen una major estabilitat en la unió 

amb VCAM-1 que 6.10  

Essent coherents amb aquests raonaments, es van buscar més estructures que mostressin 

activitat davant proteïn-cinases. Els grups carbonil, veïns de l'anell indòlic actuen com acceptors 

de ponts d'hidrogen quan s'orienten cap als residus d'aminoàcids. L'anell benzènic pot establir 

interaccions hidrofòbiques també amb residus hidrofòbics d'aminoàcids. A l'article citat en 

aquest paràgraf es realitzen dockings i expressen la necessitat de realitzar sobre aquesta 

estructura estudis més detallats. És per aquest motiu que s'ha decidit fer el docking entre 6 i 

VCAM-1.11  

Per completar l'estudi dels indols 3-substituïts, s'han realitzat els dockings de les estructures 9 i 

10, que parteixen de 7 incrementant la longitud de la cadena hidrocarbonada, els resultats 

indiquen que a major longitud, menor estabilitat de la unió amb VCAM- 1 i confirmen la nostra 

suposició prèvia de treballar amb molècules amb anells fusionats i poques unitats CH2  entre 

grups. 

Addicionalment, s'han fet càlculs realitzant substitucions en altres posicions.  

L'anàlisi de les dades en la taula 3 indica que la millora és notable en 13, ja que hem obtingut el 

millor resultat fins al moment. Es constata que el canvi d'un anell de 6 a 7 membres (en les 

estructures 11 i 14) produeix variacions mínimes. En canvi, en 13 l'increment és notable superant 

fins i tot els indols 3 substituïts. Per tant, serà interessant l'estudi de nous indols amb variacions 

en aquestes posicions i volum semblant.  

TAULA 3: valors d’afinitat en Kcal/mol. En indols substituïts en posició 4, 5, 6, 7. 
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En un intent ràpid de veure quines estructures ens resulten més favorables des del punt de vista 

energètic, es van realitzar els dockings dels productes resumits en la taula 4. Seguint amb el 

nostre raonament de treballar amb estructures amb anells fusionats, es van realitzar els 

Dockings 17 i 18. 

Els grups voluminosos units a indols que ja havien demostrat possibilitats (molècula 19) amb un 

grup, amb tres ciclohexans fusionats i grups carbonils per potenciar la formació d'enllaços per 

pont d'hidrogen.  

TAULA 4: valors d’afinitat en Kcal/mol en estructures anàlogues a productes descrits a la 

bibliografia farmacològicament actius i estructures suggerides. 

 

La molècula 20 és una proposta basada en l'estructura de pembrolizumab (substituint el grup 

fenil de l'extrem per un indol. És notable la bibliografia que descriu pembrolizumab com un 

fàrmac diana a sintetitzar ja que es troba relacionat en processos d'inhibició en melanoma i 

altres tipus de càncer. Recentment, la FDA (Food and Drug Administration) ha aprovat 

pembrolizumab, sota el nom de Keytruda, com a teràpia en el tractament del melanoma. 12 
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Finalment, a la 21, se sintetitza en una sola estructura els grups funcionals i cicles lliures i 

fusionats que ens han donat millors resultats per veure si mostraven un efecte sinèrgic en el 

conjunt. 

La unió de l’indol amb grups aromàtics ha donat resultats positius i, per tant, s'ha decidit 

desenvolupar algunes d'aquestes molècules per tractar d'obtenir millors resultats: 

TAULA 5: valors d’afinitat, en Kcal/mol, per a derivats indòlics substituïts en posició 2. 

 

He col·locat grups OH en un costat de la molècula, en ambdós costats i, finalment, a l'altra banda; 

a partir dels resultats deduïm que és més favorable afegir radicals en un sol costat.  

Hem notat un petit increment de l'estabilitat de la nostra unió fa a les molècules 14-16 en 

convertir els enllaços senzills del grup OH en enllaços dobles; no obstant, la millora més notable 

té lloc en afegir un grup 3-mercapto-1,2,4-triazole en un dels extrems, com suggereix alguna 

publicació en la qual es descriuen índoles biològicament actius.13  
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Com a comentari, és interessant fer referència als càlculs realitzats amb pèptids units als nostres 

anells d’indol. Tot i trobar-se descrits en la bibliografia exemples de lligands amb aquesta 

estructura i interaccions favorables, en el nostre cas no va ser així pel que es va desestimar 

aquesta línia d'estudi.14 
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4.1.3. Imatges dels dockings 

A continuació, mostrarem imatges dels Dockings més rellevants, és a dir, les unions amb els 

derivats indòlics que han donat millors resultats.  

 

La imatge és una captura de pantalla del programa Autodock tools, amb el qual hem realitzat i 

visualitzat el docking. Es pot veure VCAM-1, l'estructura més gran, i el lligand 25, que és 

l'estructura petita de color rosa. S'ha col·locat de perfil perquè és la conformació més estable 

que pot adoptar respecte a VCAM-1, però la podem reconèixer (a part de pelseu color rosa) per 

la seva grup 3-mercapto-1,2,4-triazol. 

Altres dockings rellevants son els que hem realitzat amb els lligands 13 i 18: 
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4.2. QUINOLINA 

Per analitzar els resultats dels Dockings, realitzarem la quadrícula que ja havíem 

presentat en l'apartat que porta per títol: "Disseny de medicaments". En gris, apareixen 

marcades les molècules amb una energia d'unió (o de Gibbs) més alta en cadascun dels 

hidrògens. Primer, haurem de numerar cadascun dels set hidrògens de la molècula, un 

cop haguem fet això, procedirem a substituir-los per un grup alcohol, un grup amino, un 

fluor i un metil. A continuació, presentem una imatge on s'observa clarament com hem 

numerat els hidrògens de la nostra molècula: 

                                                                     Figura 4 

 

 

 

 

Els resultats han estat els següents: 

Taula : Energia d'unió (Kcal/mol) de la quinolina_1 (Figura 4) al substituir l'Hidrogen. 

Substituent H1 H2 H3 H4 H5 H6 H7 

Hidroxil (-OH) -5,4 -5,2 -5,4 -5,4 -5,5 -5,4 -5,4 

Amina (-NH2) -5,4 -5,2 -5,4 -5,3 -5,5 -5,5 -5,4 

Fluoro (-F) -5,4 -5,0 -5,1 -5,0 -5,1 -5,0 -5,1 

Metilo (-CH3) -5,1 -5,0 -4,9 -5,0 -5,2 -5,2 -5,0 

*Els millors resultats del Docking es mostren en negreta sobre un fons gris. 

 

Podem observar que els resultats amb una energia més negativa són l'alcohol i l'amina 

de l'hidrogen 5, i després també tenim l'amina en l'hidrogen 6. Aquests dos hidrògens 

són per on hem d'anar fent créixer la molècula, ja que serà per aquí d'on obtindrem un 

fàrmac virtualment útil contra la VCAM-1. 

Per continuar, el que hem fet ha estat començar a modificar la molècula, afegint altres 

grups mitjançant el programa Symyx Draw. Hem anat provant una mica a l'atzar, fins a 

obtenir els valors que apareixen a la següent quadrícula i que corresponen als millors 

resultats: 

Nom Energia d'unió 
(kcal/mol) 

Nombre de ponts 
d'hidrogen 

Molècula_1 -7,9 1 

Molècula_2 -7,8 1 

Molècula_3 -8,1 0 

Molècula_4 -7,9 0 
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La molècula número 3 és la que ens ha sortit amb una energia de Gibbs més negativa9, 

per tant, el que farem ara és anar-la variant per intentar trobar una molècula encara 

millor.  

Les imatges que es presenten tot seguit, ens mostren com és el disseny de la 

molècula_3, la més negativa fins al moment que té una energia d'unió de -8,1kcal/mol:  

  

 

 

 

 

 

 

 

 

                                                           
9 A mida que aquesta energia sigui menor, més estable serà la molècula.  
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Figura 5 

Però, aquesta estructura no la podem considerar com un bon fàrmac, encara que sí 

com a un bon inhibidor, ja que la molècula no compleix les regles de Lipinski: té 

moltíssims grups hidroxil, un grup peròxid que és molt reactiu i es degradaria només 

arribar a l'estómac i no serviria per unir-se a la VCAM-1 i, finalment, el compost no té 

aromaticitat, no compleix la regla de conjugació dels compostos cíclics aromàtics de  4n 

+ 2 electrons deslocalitzats (llei de Hückel10). Per tant, rebutgem el compost ja que 

podem aconseguir millors resultats amb una estructura més estable i menys hidrofòbica 

per dins i polar i hidrofílica per fora. 

 

Hem intentat dissenyar diferents molècules que tinguessin la màxima energia d'unió a 

més de complir les cinc regles de Lipinski. Amb els resultats obtinguts, podem elaborar 

la següent quadrícula: 

Nom Energia d'unió 
(kcal/mol) 

Nombre de ponts 
d'hidrogen 

Molècula_5 -5,6 1 

Molècula_6 -6,4 0 

Molècula_7 -7,2 0 

Molècula_8 -5,3 1 

Molècula_9 -7,4 1 

Molècula_10 -7,5 1 

Molècula_11 -7,5 0 

Molècula_12 -7,5 0 

Molècula_13 -6,5 0 

Molècula_14 -7,7 0 

                                                           
10 Llei que indica que una molècula és aromàtica si té 4n+2 electrons π i antiaromàtica si té 4n electrons 

π. 
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Molècula_15 -7,0 1 

Molècula_16 -7,4 0 

Molècula_17 -7,0 0 

 

Observem que la molècula_14 és la que té una energia d'unió més negativa; a més a 

més, té un pes molecular inferior a 500 Dalton, té menys de 5 donadors de ponts 

d'hidrogen i menys de 10 acceptors. De la mateixa manera, el seu resultat del log P és 

inferior a 5. Per tant, afirmem que compleix les cinc regles de Lipinski. Així mateix també 

podem afirmar que és una molècula hidrofílica, que pot transportar-se perfectament 

per mitjans aquosos com la sang. 

 

 

 

 

 

La seva estructura és la següent: 
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      Figura 6 

Veiem com, en el centre de l'estructura, encara mantenim la quinolina i per determinar 

per on havíem de fer créixer la molècula, hem fet un docking afegint una ramificació a 

cadascun dels hidrògens. Els que ens han sortit amb una energia de Gibbs més negativa 

són l'hidrogen 3 i l'hidrogen 5. Per tant, ramifiquem la molècula per aquests dos costats.  

A continuació, presentarem 3 captures de pantalla del programa AutoDockTools de la 

molécula_14 que ens permetran fer-nos una idea de com és el seu comportament i de 

com s'ajusta amb la VCAM-1 (el centre actiu), mostrant també quins són els aminoàcids 

amb els quals s'uneix el fàrmac. 
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En aquesta primera imatge, apreciem clarament quin és el centre actiu de la VCAM-111, 

on s'ajusta la nostra molècula_14 i que inhibeix les seves propietats per a produir 

metàstasi.                     Figura 7 

 

Observem que el centre actiu de la VCAM-1 està situat al centre de la molècula (zona 

assenyalada pel cercle taronja). També podem veure que l'energia d'unió de la molècula 

amb la proteïna és -7,7 kcal / mol. 

 

 

 

 

 

 

 

 

                                                           
11 La VCAM-1 està representada en verd, mentre que la nostra molècula_3 (la quinolina variada), està 

representada amb un color rosat. 
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A la segona captura de pantalla, podem observar-hi també el centre actiu de la VCAM-1 

amb la seva estructura secundària (de color groc):                            Figura 8 

A la següent imatge, observem que no hi ha cap pont d'hidrogen en la molècula_14; 

veiem també quins són els aminoàcids amb què  s'uneix la variació de la VCAM-1 

(LEU12, GLU67, GLU179, ARG146, ARG123, ILE177).    Figura 9 

 

 

 

 

 

 

 

 

 

 



Una adhesió no desitjable                                                                                                                      38                                                                                                                  

 

A continuació, expliquem com hem obtingut la nostra molècula_14 a partir de la 

quinolina. Primerament, hem afegit una ramificació en tots els hidrògens, hem observat 

que en afegir-la als hidrògens 3 i 5 l'energia de Gibbs era més negativa. Hem començat 

a augmentar la molècula per aquests dos costats. Hem anat afegint diferents 

ramificacions en aquests dos hidrògens tenint en compte en tot moment que la 

molècula complís les 5 regles de Lipinski. Però, no ha estat fins a realitzar la molècula_9 

que hem obtingut una energia d'unió suficientment alta per considerar-la un bon 

inhibidor (-7,5 kcal / mol). 

La seva estructura és la següent: 

 

 

 

 

 

 

 

 

 

 

Observem que en afegir el ciclopentà amb dos oxígens i el ciclohexà amb un enllaç 

simple a l'hidrogen 3, juntament amb un altre grup igual canviant els dos oxígens per 

dos nitrògens en l'hidrogen 5, l'energia d'unió pujava considerablement. Per tant, 

aquests dos grups ja els mantenim. El que hem fet a continuació ha estat tractar de 

variar els enllaços de la quinolina en unir-se amb les ramificacions per observar si el 

fàrmac s'unia amb una major afinitat amb la VCAM-1. 
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Les variacions que hem fet, són les següents: 

1. Molècula_11: Hidrogen 3: Enllaç simple --> Nitrogen --> Enllaç simple 

   Hidrogen 5: Enllaç simple  

2. Molècula_12: Hidrogen 3: Enllaç simple --> Oxigen --> Enllaç simple 

   Hidrogen 5: Enllaç simple  

3. Molècula_13: Hidrogen 3: Enllaç simple --> Carboni --> Enllaç simple 

   Hidrogen 5: Enllaç simple  

4. Molècula_14: Hidrogen 3:  Enllaç simple --> Carboni --> Enllaç simple  

   Hidrogen 5: Enllaç simple --> Nitrogen --> Enllaç simple 

5. Molècula_15: Hidrogen 3:  Enllaç simple --> Carboni --> Enllaç simple  

   Hidrogen 5: Enllaç simple --> Oxigen --> Enllaç simple  

6. Molècula_16: Hidrogen 3:  Enllaç simple --> Carboni --> Enllaç simple  

   Hidrogen 5: Enllaç simple --> Carboni --> Enllaç simple  

Ara presentem les estructures de cada una de les molècules dissenyades amb els seus 

respectius valors d'energia d'unió: 

Molècula_11 (-7,5 kcal/mol):    Molècula_12 (-7,5 kcal/mol): 
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Molècula_13 (-6,5 kcal/mol):    Molècula_14 (-7,7 kcal/mol): 

 

 

 

Molècula_15 (-7,0 kcal/mol):    Molècula_16 (-7,4 kcal/mol): 
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En observar que la molècula_14 és amb la qual hem obtingut uns millors resultats, hem 

tractat d'introduir una nova variació en la seva estructura, per comprovar si encara 

podíem millorar més la seva energia d'unió: 

 

 

 

 

 

 

 

 

En dissenyar aquesta nova molècula, l'energia d'unió ha empitjorat fins a -7,0 kcal/ mol. 

Per tant, descartem fer més canvis i ens quedem amb la molècula_14 que és la més 

estable i que, a més, compleix les 5 regles de Lipinski i s'ajusta millor amb la VCAM-1. 

Un avantatge que ens proporciona el programa AutoDock Tools és que, només clicant 

les fletxes del teclat, podem observar les diferents maneres que té una mateixa 

molècula d'adaptar-se a la VCAM-1. Per exemple, la variació de la quinolina que hem 

escollit com a millor compost, en funció de la seva manera d'ajustar-se amb la VCAM-1 

podria tenir les següents energies d'unió: 

Molècula_14 (1) -7,7 kcal/mol 

Molècula_14 (2)  -7,1 kcal/mol 

Molècula_14 (3) -6,5 kcal/mol 

Molècula_14 (4) -6,4 kcal/mol 

Molècula_14 (5) -6,4 kcal/mol 

Molècula_14 (6) -6,3 kcal/mol 

Molècula_14 (7) -6,1 kcal/mol 

Molècula_14 (8) -6,0 kcal/mol 
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A les següents imatges, mostrem com hi ha diferents maneres de col·locar la molècula 

i que en funció de com s'ajusta amb la VCAM-1 té una energia d'unió diferent; els 

valors d'aquesta unió, en el cas de la molècula_14, oscil·len entre -7,7 i -6,0. 

Molècula_14 (1): -7,7 kcal/mol      Figura 12 

 

 

 

 

 

 

 

 

 

 

 

Molècula_14 (2): -7,1 kcal/mol      Figura 13 
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Molècula_14 (3): -6,5 kcal/mol      Figura 14 

 

 

 

 

 

 

 

 

 

 

 

Molècula_14 (4): -6,4 kcal/mol      Figura 15 
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Molècula_14 (5): -6,4 kcal/mol     Figura 16 

 

 

 

 

 

 

 

 

 

 

 

Molècula_14 (6): -6,3 kcal/mol     Figura 17 
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Molècula_14 (7): -6,1 kcal/mol     Figura 18 

 

 

 

 

 

 

 

 

 

 

 

Molècula_14 (8): -6,0 kcal/mol     Figura 19 
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Figures quinolina: 

Figura 4: Imatge de la quinolina amb la nostra pròpia numeració per indicar quin ordre hem 

seguit a l'hora de fer les modificacions a la molècula. 

Figura 5: Imatge que mostra com és el disseny de la molècula de quinolina variada per 

aconseguir una energia de Gibbs molt més negativa. Captura de pantalla del programa Symyx 

Draw.  

Figura 6: Captura de pantalla del Symyx Draw, on es mostra l'estructura de la molècula_14 que 

hem dissenyat.  

Figura 7 i 7 ': Captura de pantalla del programa Autodock Tools on s'observa com s'ajusta la 

molècula_14 al centre actiu de la VCAM-1.  

Figura 8: Captura de pantalla del programa Autodock Tools on s'observa també el centre actiu 

de la VCAM-1 a més a més de la seva estructura secundària (groc).  

Figura 9: Captura de pantalla del programa Autodock Tools on veiem, en un fons blanc, amb 

quins aminoàcids interactua la variació de la quinolina que hem creat. 

Figura 10: Captura de pantalla del programa Symyx Draw, on podem veure la molècula_9 que 

ha estat la primera que hem obtingut amb una energia d'unió suficientment alta per considerar-

la un bon inhibidor i que ens ha servit de base per a obtenir la molècula_14.  

Figura 11: Captura de pantalla del programa Autodock Tools on presentem la nova variació de 

la molècula_14, ja que volíem comprovar si encara podíem millorar més la seva energia d'unió.  

Figures 12, 13, 14, 15, 16, 17, 18, 19: Captures de pantalla del programa Autodock Tools per 

mostrar que una mateixa molècula, en ajustar-se de maneres diferents amb la VCAM-1, pot tenir 

diverses energies d'unió.  
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5. Conclusió 

Gràcies a la tècnica del docking, hem pogut determinar amb valors numèrics l'afinitat entre dues 

molècules, és a dir, com d'estable és la seva unió. Així mateix s’ha pogut comprovar que tant 

l’estudi computacional com el correcte disseny del lligand son eines indispensables al camp de 

la síntesi de compostos orgànics i fàrmacs en particular. 

A mesura que hem avançat en la investigació, ens hem adonat que hi ha certes estructures que, 

unides a l’indol, provoquen una millor adhesió d'aquesta molècula amb la proteïna VCAM-1. 

Aquests són els grups més voluminosos (d'ells, l’antranil ha estat el que ha donat millors 

resultats), els anells fusionats i les substitucions en la posició 3 de l’indol. Per contra, els grups 

discrets i petits no han donat bons resultats. A partir de les observacions fetes, s'han pogut 

dissenyar molècules cada vegada més afins amb VCAM-1. La que ens ha donat un millor resultat 

és la número 25 (-7,3kcal/mol) seguida de 13 i 18 (-7,2 i -7,0 kcal/mol, respectivament).  

En quan a la quinolina, podem afirmar que hem dissenyat un fàrmac virtual que s'ajusta al centre 

actiu de la VCAM-1 interactuant amb els aminoàcids LEU12, GLU67, GLU179, ARG146, ARG123 

i ILE177. L'energia de Gibbs del nostre fàrmac, la molècula_14, és de -7,7 kcal / mol, un valor 

bastant alt, tenint en compte que el punt de partida era de -4,7 kcal / mol, que és l'energia d'unió 

que tenia la quinolina amb la VCAM-1. Hem tingut en compte que el nostre fàrmac complís les 

5 regles de Lipinski.  

 

Al llarg d’aquest projecte s’ha après a relacionar aspectes com la flexibilitat dels enllaços, la 

voluminositat dels grups, les electronegativitats dels àtoms i la possibilitat de que es produeixin 

interaccions intra i intermoleculars amb valors canviants d’energia, calculats mitjançant el 

docking. Així doncs, s’ha canviat el concepte inicial del mètode d’assaig i error per una valoració 

conscient de la causa i l’efecte. 

Tot i que a la bibliografia es troben descrits lligands amb estructura peptídica que poden 

funcionar en processos de reconeixement similars al que hem estudiat, en el nostre cas no va 

ser així, i vam obtenir valors d’energia elevats (sistema inestable). Per tant, es va decidir 

descartar aquesta línia d’investigació, tot i que podria ser un futur objectiu a investigar amb més 

profunditat.  

Aquest treball m’ha permès aprofundir en aspectes que mai abans m’havia plantejat que 

poguessin funcionar d’aquesta manera. Per exemple, el fet que qualsevol procés bioquímic, per 
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simple que sembli, és una complexa seqüència de reconeixements entre substrat i lligand que 

impliquen diferents respostes. 

Tot i que els inhibidors que hem dissenyat busquen la millor complementarietat amb la diana 

del treball, i no s'ha tingut en compte la seva facilitat de síntesi, algunes molècules com la 

número 7 sí que són molècules de síntesi.  

Tot i que no podem quantificar fins a quin punt les molècules dissenyades tenen potencial 

farmacològic, hem pogut millorar notablement la capacitat d'inhibició que tenen tant el derivat 

indòlic com el quinolèic, dissenyat sobre VCAM-1, complint així l'objectiu d'aquest estudi. 

Ens vam posar en contacte amb el Dr. Massagué, sobre la nostra iniciativa i ens va advertir que 

amb els seus estudis havia descobert que en atacar la VCAM-1, l'únic problema que tindríem 

seria que només evitaríem la metàstasi al pulmó o a l'os, però no al cervell ni al fetge. Per tant, 

això limitaria l'aplicació del tractament en els malalts que estiguin afectats per la metàstasi en 

tots aquests òrgans.  
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http://www.google.com/search?tbo=p&tbm=pts&hl=en&q=ininventor:%22Tai-Nang+Huang%22
http://www.google.com/search?tbo=p&tbm=pts&hl=en&q=ininventor:%22Kenneth+G+Hull%22
http://www.google.com/search?tbo=p&tbm=pts&hl=en&q=ininventor:%22Achytharao+Sidduri%22
http://www.google.com/search?tbo=p&tbm=pts&hl=en&q=ininventor:%22Jefferson+Wright+Tilley%22
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NCBI- National Center for Biotechnology Information (Pubmed/Medline): 

www.ncbi.nlm.nih.gov/ncbisearch 

Web of Knowledge (Universitat de Girona) 

 

Bases de dades de patents d’accés lliure  

Spacenet 

Patentscope 

Patente A: http://www.google.com/patents/WO1999010313A1?cl=en 

Artículo 7: http://www.ncbi.nlm.nih.gov/pubmed/24002113 

 

Pàgines webs 

http://escuela.med.puc.cl/publ/patologiageneral/patol_095.html     març 2014 

http://training.itcilo.it/actrav_cdrom2/es/osh/ic/91225.htm          març 2014 

http://www.cancer.gov/espanol/cancer/que-es   març 2014 

http://www.who.int/mediacentre/factsheets/fs297/en/   abril 2014 

http://www.who.int/topics/cancer/es/     abril 2014 

https://www.aecc.es/SOBREELCANCER/ELCANCER/Paginas/Fasesdelaenfermedad.aspx 

         maig 2014 

http://lema.rae.es/drae/?val=metástasis    juny 2014 

http://escuela.med.puc.cl/publ/patologiageneral/patol_095.html juliol 2014 

http://www.cancer.gov/espanol/recursos/hojas-informativas/tipos/metastatico-respuestas

         juliol 2014 

http://www.cosmos.com.mx/wiki/dpdl/Quinolina   agost 2014 

http://www.actaodontologica.com/ediciones/1999/3/moleculas_adhesion_importancia.asp

         agost 2014 

http://www.scielo.org.ve/scielo.php?pid=S0001-63651999000300034&script=sci_arttext

         agost 2014 

http://www.uv.es/tunon/QComp/Sesion_QC_Entorno.pdf  agost 2014 

http://sociedad.elpais.com/sociedad/2013/10/09/actualidad/1381313884_234389.html 

http://www.babylon.com/definition/regla%20de%20Hückel/  agost 2014  

  

http://www.ncbi.nlm.nih.gov/ncbisearch
http://www.google.com/patents/WO1999010313A1?cl=en
http://www.ncbi.nlm.nih.gov/pubmed/24002113
http://www.babylon.com/definition/regla%20de%20Hückel/
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7. Agraïments: 

M'agradaria agrair a totes les persones que d'alguna manera o altra han ajudat a què aquest 

estudi s'hagi pogut realitzar: 

Primerament al Sr. Manel Montoliu (tutor del treball) i al Sr. Aleix Viñolas (professor a la 

Universitat de Navarra, llicenciat en química i bioquímica i estudiant de Doctorat en 

Medicaments i Salut) que em van donar el privilegi d'oferir-me la possibilitat de realitzar una 

monografia en aquest camp en posar-me en contacte amb els estudis del Dr. Massagué. 

A Gemma Cabarrocas, gràcies a qui vaig poder consultar articles i fer un estudi amb el màxim 

rigor científic. També per donar-me accés a llibres i a tot el seu coneixement en química. 

També als meus pares per ser, com sempre, els qui em donen el suport necessari per poder dur 

a terme una tasca tan important. 

Al Sr. Fèlix Bruguera per dedicar una part del seu temps a realitzar la correcció lingüística del 

treball. 

Als meus companys de col·legi Santi Caireta i Adrià Marly, de la promoció anterior a la nostra, 

que ens van introduir (a mi i a l’Arnau) al món de la química computacional i ens van ensenyar 

com fer els Dockings, com dissenyar molècules... i tot allò que en un principi ens semblava tan 

lluny i tan complicat. 

Donar gràcies al nostre col·legi, Bell-lloc del Pla, que ens ha prestat les seves instal·lacions i el 

seu material, bàsicament una trentena d'ordinadors, durant les vacances d'estiu que ens ha 

permès realitzar els Dockings de manera ràpida i eficaç.  

També voldria agrair tant a la Universitat de Girona (UdG), per atorgar-me una beca Botet i Sisó 

i prestar les seves instal·lacions i material; com al Sr. Pedro Salvador, professor de química 

computacional a la Universitat de Girona, que em van assignar en guanyar la Beca Botet i Sisó, i 

qui ens va donar unes classes sobre les dianes biològiques i altres programes per fer Dockings.  

I, finalment, al Dr. Joan Massagué, les investigacions aporten nova llum en aquest complicat 

camí que, sens dubte, portarà al nostre savi, a resoldre aquelles incògnites que, ara per ara, 

presenta aquesta maligna malaltia. Moltes gràcies per les seves investigacions, per l'ànim que 

ens va donar la seva resposta al nostre missatge i la seva confiança en el nostre humil treball. 

Gràcies. 
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8. Apèndix: La resposta del Dr. Massagué 

Al principi i al final d’aquest projecte, justament amb el tutor del treball ens vam posar en 

contacte amb el Dr. Massagué via correu electrònic, per presentar-li el treball. Sense cap mena 

de dubte, la seva resposta va ser un factor motivant molt gran en aquest treball, per la seva 

categoria i la seva visió encoratjadora del nostre projecte. A continuació veiem la resposta que 

vam rebre al començament del projecte i la que vam rebre quan li vam enviar els resultats de la 

investigació:  

 

Benvolgut Professor Montoliu, 

Moltes gràcies per l'amabilitat de posar-me al corrent de la vostra magnifica iniciativa 

d'assignar als alumnes projectes de recerca basats en avenços científic d'actualitat.  Estic molt 

honrat de que s'hagi fixat en el treball del meu grup com a base per un d'aquests projectes.  

Penso que atacar la proteïna d'adhesió VCAM-1 amb molècules de disseny que bloquegin la 

seva activitat d'unió al contrareceptor VLA4 (integrines alfa-4) és molt meritori. Nosaltres 

mateixos ho em considerat, però hi ha tants projectes a fer que no donem l'abast. Ara mateix 

ens veiem forçat a centrar-nos en la molècula relacionada, L1CAM. Per tant, és molt important 

que altres grups de científics, incloent els seus alumnes de batxillerat, prenguin l'iniciativa de 

seguir allà on nosaltres no podem arribar.  

Referent a atacar VCAM-1, la única prevenció que jo tindria és que potser només seria efectiu 

contra la metàstasi al pulmó  a l'os, però no al cervell o al fetge. Això limitaria l'aplicació del 

tractament en el cas de malalts que estiguin afectats per metàstasi en tots aquests òrgans. 

Però, al capdavall, cal intentar-ho per saber la resposta. 

Amb les meves cordials salutacions a vostè i als seus alumnes, que prego faci extensives a en 

Ramón Moncunill, 

Atentament, 

Joan Massagué, Ph.D. 

Director 

Sloan Kettering Institute 
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Benvolgut Sr Montoliu, 

Em va agradar molt rebre els resultats d'aquests projectes, ara fa uns dies, quan em trobava a 

Barcelona per les festes. Fins avui, situat en un cul de món dit Washington, a l'estat nord-americà 

de Connecticut, no he trobat una estona per respondre. 

Vaig llegir els dos treballs fil per randa. Els projectes em vam semblar molt sofisticats i assenyats, 

especialment considerant que els seus autors no son experts en la matèria. Be, potser no ho son 

ara, però, ves a saber. Les vocacions científiques, o per qualsevol altra cosa, sorgeixen dels 

estímuls més impensats. Només el pas del temps en mostra el resultat. En el meu cas va ser el 

meu mestre de ciències naturals, en Joan Geli, i mon pare, un farmacèutic nascut  Vallmoll, a 

l'Alt Camp, que van catalitzar la meva inclinació de naturalista al 13 anys. Des de l'ornitologia a 

la botànica, a la bioquímica i sobretot la meva passió real, la mineralogia. Vaig quedar infectat, i 

ja no hi va haver remei. 

La meva enhorabona a vostè per estimular el jovent a 'fer coses' que van més enllà del Whatsapp 

i la Lady Gaga (ep, una artista excepcional, tot sigui dit). La meva gratitud per haver-me inclòs, 

encara que de fos de maneta tangencial, en aquest meritori projecte. 

 

Desitjant-vos un Bon Any Nou, 

Joan Massagué, Ph.D. 

Director 

Sloan Kettering Institute 

 


